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Accessing Data ManagementAccessing Data Management 
 
If there is an icon for Data Management, or DMT, on your desktop, double-click it to start the program. 

 
If you do not have an icon on the desktop: 
Click Start > Programs > Sigma Systems > Data Management. 
 
Enter your User ID and your password, then click the Connect button, or just press the Enter key. 

 
The Search Screen will appear after you have logged in; it will be covered in detail in the Entering a New Parcel and 
Searching for Existing Data sections of this user guide. 
 
The Search screen lets you: 

• Search for an existing parcel in the Inventory file or Sales file 
• Add a new parcel to either the Inventory file or Sales file 

You may search for a parcel using Parcel ID, Parcel Address, Owner Name or a custom combination of fields. 
Parcel ID is the primary search key, so whenever you log in you will see the Parcel ID field by default. 
 
You will also see a menu bar at the top of the screen. This menu bar contains options and system settings; you can 
use the menu bar to: 

• Run reports 
• Run Cost 
• Run a utility program 
• Apply batch transactions 
• Use the file Viewer 
• Change your default options 
• Access the Help system 

 
Under the menu bar is the tool bar. The toolbar contains icons that, when clicked with the mouse, run certain 
programs or perform tasks. Some of the options in the menu bar are also represented by an icon on the tool bar. 
 
The menu bar and tool bar are described in detail below. 
 

The Menu Bar 
A menu bar appears at the top of the screen. Click on the word to open the associated menu (for example, click on 
the word File to open the File menu.)  
 Menu bar 

Tool bar
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The basic functions found in the menus are: 
 
File 
 

   
Path Names – defines the paths to the user’s working and data directories 
Print – prints a file (the user’s working directory is the default location) 
Print Setup – changes the current Windows printer setup 
Run – starts the RPIS Utilities or Valuation modules 
View Log File – displays the system error log file 
Exit – exits the RPIS DMT module 
 
 
 
 

 
Edit 
 

 
The Edit menu contains the standard text editing commands (cut, copy, paste and undo) 
 
 
 
 
 

 
Value 

 
Cost – opens the Cost valuation screen 
Income – opens the Income valuation screen 
Condo – opens the Condo valuation screen 
 
 

 
Record 

 
This menu contains options that deal solely with the current parcel: 
Save – saves the current record 
Delete – deletes the current record 
Copy – brings up the Copy window with options for copying the current record 
Errors – runs an error check on the current record 
X-Edits – runs a cross-edit error check on the current record 
Cost – runs Cost valuation on the current parcel 
Income – runs Income valuation on the current parcel 
Condo – runs Condo valuation on the current parcel 
Property Record Card – prints a PRC for the current parcel 

GUI Parcel List – prints a detailed parcel listing for the current parcel 
Error Summary Listing – prints a list of all errors found in the current parcel 
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Reports 
 

 
This menu contains various preprogrammed reports that can be run on any number 
of parcels: 
GUI Parcel Listing 
Error Summary 
Data Dictionary 
Audit Trail 
Property Record Card 
LA-3 Report 
LA-4 Report 

 
Utilities 
 

The Utilities menu used to be in a separate module – in Version 3, you can now run all 
utility programs from the DMT module. 
 

 
 
 

 
 

Tools 

 
Batch Transactions – for applying batch transactions to the database 
Report Preview – for viewing text files and reports 
Calculator – an electronic calculator tool 
Update Builder – for batching data into the database (only certain RPIS users 
will have permission to run Update Builder.) 

 
Options 

 
The Options menu contains options that can be toggled on or off (an option is “on” if 
there is a check mark next to it): 

 5 RPIS Version 3 DMT User Guide.doc 
  03/22/2007 12:40:00 PM 

Unattended Batch – check this option if you wish to skip “process complete” 
messages that require you to click OK. 

Return to Same Data – check this option if you want RPIS 
to remember which data type you last looked at (Land, Residence, Valuation, etc.) and 
return to that screen instead of always returning to the Parcel screen. 
Save Settings on Exit – check this option to save all settings each time you exit the 
system. 

 
Help 

Contents – click Contents to bring up a list of help topics for RPIS. 
Local Help – this option is not currently supported. 
About – displays the current RPIS component versions. 
 
 



  

The Tool bar  The Tool bar  
  
Underneath the menu bar is a tool bar containing special buttons called icons. Icons represent programs or tasks; you 
click an icon to perform a certain function. The RPIS toolbar icons and their functions are described below. 
Underneath the menu bar is a tool bar containing special buttons called icons. Icons represent programs or tasks; you 
click an icon to perform a certain function. The RPIS toolbar icons and their functions are described below. 
  

 

Menu bar 

Tool bar  
 
 
 
Note: The tool bar is always visible in every data type, but not all icons are visible all the time.   

 
New Record:  click to add a new record where one already exists (for example, a second residence record or 
land record.) 

 

 Save:  click to save the current record.  Whenever a data change is made (even if you just click inside a field 
without changing anything) this icon will become active and RPIS will prompt you to save data. 
 

 Copy: click to access the Copy record screen. 
 

 Delete record: click to delete the current data type. (Note: As in previous RPIS versions, if you delete the 
Parcel datatype, every datatype attached to that parcel will be deleted as well.) 
 

 Matching Parcel navigation icons: if you choose a parcel from a Matching Parcels list (for example, 
if you searched for a street name or owner name and didn’t type in the specific map & lot yourself) the Matching 
Parcel navigation icons will be active. 
 
The arrow icons allow you to move backwards and forwards on the parcel list without actually going back to the list 
itself. You can also return to the list and choose a new parcel by clicking the List icon (the picture of a list with the 
green plus sign.) 
 
Example:  if you asked for parcels on DEPOT RD and then selected 10 DEPOT RD,  
you could move to 8 DEPOT RD by clicking  
or you could move to 11 DEPOT RD by clicking  
or, to return to the DEPOT RD matching parcels list, click  
 
 

Find:  clicking this button will return you to the Search Screen. If you made changes but did not click the 
Save button, RPIS will ask if you wish to save changes before going to the Search Screen. Click Yes to save 

the changes or No to discard the changes. 
 

 Check Errors: click to view any errors in the data; you can choose to Fix the errors or Accept them 
temporarily, so you can fix them later. Whenever RPIS sees a data error, this icon will become active and will 
remain so until the error is fixed. 
 

 Cross (X)-Edits: click this button to have RPIS search for Cross-Edit errors (particularly useful in the 
Residence data type.) A cross-edit error is a mismatch between 2 data fields, like a ranch style residence that’s listed 
as having 2 stories.  If RPIS finds a cross-edit error, it will ask if you wish to display it. Click Yes to view the error 
or click No to cancel. If you click the cross-edit icon and no errors are found, nothing will be displayed. 

 
View/Add Image: click this icon to view an existing parcel photo, or to add a new one. 
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Sketch: click this icon to view, edit or add a sketch (this icon is only active when you are viewing a 
Residence record.) 
Sketch: click this icon to view, edit or add a sketch (this icon is only active when you are viewing a 
Residence record.) 

  
View Notes: click this icon to view any notes (memos) about the parcel. View Notes: click this icon to view any notes (memos) about the parcel. 
  

  
Run Market Analysis: click this icon to access the market analysis tools (Market Analysis, Comparable 
Analysis, Automatic Cost Calibrator etc.). 
Run Market Analysis: click this icon to access the market analysis tools (Market Analysis, Comparable 
Analysis, Automatic Cost Calibrator etc.). 

  
Run Cost: click this icon to run Cost on the current parcel, using the current cost options. Note: to change 
the Cost Options (factors, year for depreciation, etc.) click Value on the menu bar, then click Cost, then 

Select Options. 

Run Cost: click this icon to run Cost on the current parcel, using the current cost options. Note: to change 
the Cost Options (factors, year for depreciation, etc.) click Value on the menu bar, then click Cost, then 

Select Options. 
  

Run Condo Valuation: click this icon to run condo valuation. Run Condo Valuation: click this icon to run condo valuation. 
  

. . 
Record navigation icons: these icons appear when viewing a multiple occurrence datatype. 
They allow you to view (in order from left to right) the first record, previous record, next record 

or last record. 

Record navigation icons: these icons appear when viewing a multiple occurrence datatype. 
They allow you to view (in order from left to right) the first record, previous record, next record 

or last record. 
  

 Add Row and Delete Row icons:  use these icons to add or delete a row from an embedded table. 
For example, in the Land record, click the Add Row icon to add a row to the embedded Land Influence table.  
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Entering a New Parcel 
 
 
After successfully logging in, the Search screen appears. You can either find an existing parcel or enter a new 
parcel. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Search 
fields 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
To add a new parcel to the database: 

1. Type the new parcel ID in the Parcel ID fi
to clear the field, then type the new parcel
the letters and numbers. 

2. Click the New Parcel button. (This button
the database.  It becomes active when you

3. A blank Parcel record will appear. You ca
4. When finished entering data, click the Sav

 
Searching for Existing Data  
 
You can use the Search screen to find an existing p
a parcel by typing a partial or full street address or 
Builder tool. The Sales database can also be search
a sale to find a specific sales parcel. If your databas
from a specific year. 
Parcel Year
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eld. (If an existing parcel ID is in the field, click the Clear button 
 ID.) You do not need to type the slashes, dashes or dots – just 

 will appear gray until you enter a parcel ID that doesn’t exist in 
 type a new parcel ID.) 
n now enter data into the record. 
e icon on the toolbar to save the Parcel record.  

arcel.  Parcel ID is the primary search field, but you can also find 
owner name. For more complex searches, you can use the Query 
ed from this screen; you will need to know the month and year of 
e contains more than one year of data, you can search for a parcel 
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Search 
fields 

File to 
search 

Parcel Year 

 
 
 
To find a parcel that already exists in the database: 
 
If you know the Parcel ID:  

1. Enter the parcel ID in the Parcel ID box. Don’t type slashes, dashes or dots – the system puts them in for 
you. Use the backspace key to erase typos, or use the mouse to highlight the text you wish to replace and 
type new information over it. 

2. Click the Execute Query button or press Enter to start the search. 
 
If you don’t know the Parcel ID: 

1. Select a field type in the Query By section by clicking the radio button to the left of the field. 
2. Type part or all of the information to search by in the appropriate box.  
3. Click the Execute Query button to start the search.  

 
Important:  Check the Parcel Year. All accounts are now year-tagged, so you must always specify the particular 
year as well as the parcel ID. 
 
Note: the Query Builder button allows more complex searches of the database. Using the query builder, you can 
create complex queries like those produced in the IQ Objects report generator. The Query Builder tool is described 
in detail in the Query Builder user guide. SQL Runner also allows complex searches by using SQL language to 
query the Oracle database. This is primarily an administrative tool for DLS and Sigma Systems use; it may be 
covered in a future user guide but is not terribly useful as a search tool.



  
Example – to search by owner nameExample – to search by owner name: 
 
Select Owner Name in the Query By section, type all or part of the owner name to search for, and click the Execute 
Query button. 
 

 
 
 
 
If the query finds more than one parcel that matches your information, a spreadsheet-style list appears. Double-click 
anywhere in a row to select a particular parcel. 
 

 
 
 
 
 
To return to the Search Screen: 
 

• Click the Find icon on the toolbar (the binoculars) or 
• Click the Parcel Search button at the bottom left of the search results screen.  
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The Main DMT screenThe Main DMT screen 
 

Datatypes 
Sheet Tabs 

Data 

Parcel 
Summary 

 
 
Once a parcel has been selected, it will be displayed in the main DMT screen. There are several sections to the main 
screen: 
 

The Parcel Summary section 
 
The parcel summary section underneath the tool bar displays information that identifies the current parcel: the parcel 
year, parcel id (map and lot), parcel location (address), owner, use, final values and the current parcel status (active 
= Y or N.) Parcels from the Sales file also display the month and year of sale. The summary section remains on 
screen regardless of the data type.  
 
When viewing a multiple occurrence record, the total records and the current record number will be displayed at the 
far right of the tool bar.  The example below shows the summary section and toolbar when viewing a land record. 
 
Parcel Summary section – land record (notice the record number indicators) 

 
 
 
 
 
The information displayed in the summary cannot be changed on the summary screen; the data is simply read from 
the parcel and valuation records. When the data in those records changes, the summary will reflect those changes.  
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The Datatype Section The Datatype Section 
The Datatype section lists all datatypes available in the database. The number of existing records for each datatype is 
displayed in parentheses after the datatype name. If the number of records is zero (if a record of that type doesn’t 
currently exist) then clicking on the datatype prompts the system to add a new record. If a record of that type exists, 
clicking on the datatype will display that data, with the Records sheet on top (see the example below, in the Using 
Sheet Tabs section.) 

The Datatype section lists all datatypes available in the database. The number of existing records for each datatype is 
displayed in parentheses after the datatype name. If the number of records is zero (if a record of that type doesn’t 
currently exist) then clicking on the datatype prompts the system to add a new record. If a record of that type exists, 
clicking on the datatype will display that data, with the Records sheet on top (see the example below, in the Using 
Sheet Tabs section.) 

Note that, in this example, some 
datatypes (Land, Value History and 
Detached Structure) have more than one 
record, and some datatypes don’t contain 
data (Condo Unit, Commercial Section, 
Abatement and so on.) 
 
Click Abatement to add a new 
Abatement record. 
 
To add a new Land record, first click 
Land to display the existing records, 
then click the New Record icon on the 
toolbar to add a new record. 

  

Using Sheet Tabs Using Sheet Tabs 
Data fields are arranged on sheets resembling file folders, with a tab at the bottom of the sheet. The sheet tab 
describes the type of information contained in the sheet. Click on a sheet tab to change pages within a record. 
Data fields are arranged on sheets resembling file folders, with a tab at the bottom of the sheet. The sheet tab 
describes the type of information contained in the sheet. Click on a sheet tab to change pages within a record. 

sheet 
tabs 

  
  
Data types that allow multiple records (land, residence, detached structure, etc.) also have an additional sheet named 
Records. This sheet allows you to select a particular record from a list, without the need to scroll through the records 
in order. 

Data types that allow multiple records (land, residence, detached structure, etc.) also have an additional sheet named 
Records. This sheet allows you to select a particular record from a list, without the need to scroll through the records 
in order. 

 12 RPIS Version 3 DMT User Guide.doc 
  03/22/2007 12:40:00 PM 



  
Click anywhere on the row to select a particular record. Once a record is selected, the record navigation icons on the 
tool bar will be active. To select another record, either use the navigation icons to scroll through the records, or click 
the Records sheet tab to return to the records list. 

Click anywhere on the row to select a particular record. Once a record is selected, the record navigation icons on the 
tool bar will be active. To select another record, either use the navigation icons to scroll through the records, or click 
the Records sheet tab to return to the records list. 
  
  

 13 R
  

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

Working with Embedded Tables Working with Embedded Tables 
  
Some record types contain a sub-set of data in a child record, or embedded table, that is attached to the main record. 
For example, the Land record contains an embedded Land Influence table, and the Residence record contains a 
Porch table.  

Some record types contain a sub-set of data in a child record, or embedded table, that is attached to the main record. 
For example, the Land record contains an embedded Land Influence table, and the Residence record contains a 
Porch table.  
  

   

The Records 
sheet tab 

 
 
There are two methods for entering data into an embedded table: 

• Click anywhere inside the embedded table and press the Insert key to
enter the data. 

• Click anywhere inside the embedded table and click the Insert Row i
 

 
              ADD  DELETE 
 
To delete a row from an embedded table, first select the row, then either  

• Press the Delete key or 
• Click the Delete Row icon.
Embedded  Land 
Influence table 
PIS Version 3 DMT User Guide.doc 
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 open a new row in the table, then 

con on the tool bar. 



 
 
 

Entering, Deleting or Changing Data 
To enter data in a field: 
Click in the field with the mouse, then type in the data. 
 
To move around the screen: 
Click inside fields with the mouse, or use the Tab key to move from one field to the next.   
 
Some fields with many different options have pull-down lists available; you can type the data into the field yourself, 
or select the desired data from the list. Click the arrow to open the list and then click your selection. This makes data 
entry easy and fast, especially for new parcels. You can also type data directly into any field, even if it has a pull-
down list. Use the method (clicking or typing) that works best for you. 
 
To delete data from a field: 
Select the information with the mouse, then press the Delete key. 
 
To delete an entire record: 
Search for the record you wish to delete. When the record is displayed on the screen, click the Delete key on the 
Toolbar. The system will ask you to confirm your intentions; click Yes to delete the record or No to cancel the 
process. 
 

Copying a Parcel or Datatype 
It is possible to copy an entire parcel, or just a single data type. Search for the parcel you wish to copy, then select 
the Parcel datatype if you wish to copy the entire parcel, or select a specific datatype if you wish to copy only that 
datatype. Click the Copy icon on the toolbar and the Copy screen will appear. 
 

 
 
 
The Copy From section contains information about the current parcel. The only information you can change is the 
Type of Data to copy from (Parcel is the default.) If you wish to copy just a single data type, select the data type 
from the pull-down list. If you select a data type that can have multiple records (like the land and residence types) 
you must specify which record to copy from and fill in the record number to copy to. 
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The Copy To section contains the Parcel Year, Parcel ID and several other options. Fill out this section according to 
what you wish to accomplish: 
 To copy a parcel to the Sales file: click Sales in the Options section. The month and year will appear above the 

word Options. Verify the month and year (change if necessary) and click Copy. 
 To copy the parcel to another parcel number in the Inventory file: change the map and lot number to the new 

parcel ID and click Copy. 
 
When copying an entire parcel (the Parcel record and all records associated with it) make sure the Copy Detail Data 
Type box is checked. If the box is left unchecked, only the Parcel record will be copied, without the associated 
records. 
 
If a parcel in the Inventory or Sales file already exists with the number you’ve selected, the system will give you a 
warning and will not complete the copy. To overwrite an existing parcel you must check the “Overwrite Existing 
Records” box. 
 
Printing DMT Reports 
 
A number of pre-programmed reports are available on the Record and Reports menus.  All reports are printed using 
the default Windows printer unless a new printer is selected using the File menu. 
 
Property Record Card – this report can be printed from: 
 the Record menu (prints only the currently displayed parcel) 
 the Report menu (prints a single card or multiple cards, according to the parcel selection) 
 the Matching Parcels screen - when multiple parcels are returned by the Search function, a button labeled PR 

Card appears underneath the matching parcels list. 
 
GUI Parcel Listing (formerly “Detailed Parcel Listing”) – this report can be printed from: 
 the Record menu (prints information from only the currently displayed parcel) 
 the Report menu (prints one or more parcel listings according to the parcel selection) 
 the Matching Parcels screen - when multiple parcels are returned by the Search function, a button labeled 

Parcel List appears underneath the matching parcels list. 
 
To change the options associated with the Parcel Listing, click Reports > GUI Parcel Listing and then click the 
Select Options button. 
 
Error Summary – this report can be printed from the following menus: 
 the Record menu (prints error information from only the currently displayed parcel) 
 the Report menu (prints error information on a single parcel or multiple parcels, according to the parcel 

selection) 
 
 
 
The following reports are available only on the Reports Menu: 
 
Data Dictionary – prints a detailed description of each data type, including field lengths, types, possible entries, and 
other restrictions. Single tables can be printed or the entire database can be described in one (long) report.  
Audit Trail – the Audit Listing shows database activity based on user-supplied criteria such as user name, field 
types, dates and parcel selections. 
LA-3 Report – prints a Sales Report (LA-3) based on parcel selection, sale date range and minimum sales price. 
LA-4 Report – prints the DOR LA-4 report showing total valuations by class. 
 
 
To create custom reports you may use the RPIS report generator, IQ/Objects, Business Objects or any ODBC 
compliant application such as Excel or Access.  IQ/Objects and Business Objects are supplied with RPIS Version 3 
and will be covered in separate user guides.
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Exiting the CAMA System 
 
Click File (on the menu bar) > Exit to close the Data Management module. You can do this from any screen; if you 
have changed data without saving it, the system will ask whether you wish to save before exiting. Click Yes or No. 
 
 
 
For training and technical support… 

 
Contact any of the DOR CAMA Information Technology Staff for further 
assistance or to ask about training opportunities. 
 

CAMA Support Help Desk 
Monday – Friday 9A-4PM excluding holidays 

1-800-521-5536    (ask for CAMA Support or extension 62350) 
  

Advisor Phone E-mail 
Mike Quinlivan 508-792-7300 

extension 22313 
quinlivanm@dor.state.ma.us

Linda Bradley 617-626-2394  bradleyl@dor.state.ma.us  
Paul Corbett 617-626-2366 corbettp@dor.state.ma.us
Don Reynolds 617-626-2356 reynoldsd@dor.state.ma.us  
Arnold Kanter 617-626-2303 kanter@dor.state.ma.us  

 
All Boston staff can be reached by dialing their direct numbers or through the CAMA Support 
Help Desk. 
 
CAMA Version 3 User Guides, our Support Guidelines and other useful information from the 
Information Technology section of the Division of Local Services can be found online at 
http://www.dls.state.ma.us. Information about the Community Software Consortium can be 
found online at www.csc-ma.us. 

 

Division of Local Services Information 
Technology Section 

P.O. Box 9569 
Boston, MA 02114-9569 

(617) 626-2300 or toll free 1-800-521-5536 
Fax (617) 626-2330 

 
Kirsten Shirer, Deputy Director of Information Technology 

436 Dwight St. Room 401 
Springfield, MA 01103 

(413) 784-1000 Ext. 20613 
Fax (413) 784-1034 
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Appendix A – Unlocking a parcel Appendix A – Unlocking a parcel 
  
When trying to access a parcel you may get the message “Row is currently locked, do you wish to view in display 
only?” This will occur when: 
When trying to access a parcel you may get the message “Row is currently locked, do you wish to view in display 
only?” This will occur when: 
  
1. You are connected to a UNIX or Windows NT system and another user has the parcel on his/her screen. 1. You are connected to a UNIX or Windows NT system and another user has the parcel on his/her screen. 
2. The parcel was open when the system crashed unexpectedly. 2. The parcel was open when the system crashed unexpectedly. 
3. The parcel was open when someone did a system shutdown or restart. 3. The parcel was open when someone did a system shutdown or restart. 
4. On some PCs, if the system goes into sleep mode, the parcel will be locked when the system restores from 

hibernation. 
4. On some PCs, if the system goes into sleep mode, the parcel will be locked when the system restores from 

hibernation. 
  
If you are on a multi-user system (UNIX or Windows NT) that has not recently crashed, ask the other system users 
if anyone is using that particular parcel id. If no other user is accessing that parcel, ask your System Administrator to 
unlock the parcel for you. If your system has recently crashed, notify the System Administrator that the parcel is 
locked. 

If you are on a multi-user system (UNIX or Windows NT) that has not recently crashed, ask the other system users 
if anyone is using that particular parcel id. If no other user is accessing that parcel, ask your System Administrator to 
unlock the parcel for you. If your system has recently crashed, notify the System Administrator that the parcel is 
locked. 
  
If you are on a single user system, follow the steps below: If you are on a single user system, follow the steps below: 
  
1. When RPIS asks if you wish to view the parcel in display only, click No.  1. When RPIS asks if you wish to view the parcel in display only, click No.  
2. On the menu bar, click Utilities > Dbs Maint > Unlock Parcel. 2. On the menu bar, click Utilities > Dbs Maint > Unlock Parcel. 
 
 
 
 

 
 
3. The list of currently locked parcels will be displayed. Look for the row containing the desired parcel.  
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4. Click the box in the “Unlock” column, then click the OK button. The parcel will be unlocked and you will be 
returned to the main (blank) Utilities screen. To unlock all parcels displayed on the screen, click the Clear All 
button. (This is particularly useful after a system crash on a busy, multi-user system.)  

 
If you are on a network and other people are using the RPIS system, find out what parcels are being accessed and 
DO NOT UNLOCK THE PARCELS IN USE BY OTHER USERS. Only unlock parcels that are not currently in 
use. 
 


	Accessing Data Management
	The Menu Bar
	X-Edits – runs a cross-edit error check on the current recor
	Batch Transactions – for applying batch transactions to the 
	Report Preview – for viewing text files and reports
	Calculator – an electronic calculator tool
	Update Builder – for batching data into the database (only c



	The Tool bar

	Entering a New Parcel
	Searching for Existing Data
	The Main DMT screen
	The Parcel Summary section
	The Datatype Section
	Using Sheet Tabs
	Working with Embedded Tables
	Entering, Deleting or Changing Data
	Copying a Parcel or Datatype

	Printing DMT Reports
	Exiting the CAMA System
	Division of Local Services Information Technology Section
	Appendix A – Unlocking a parcel



